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Preface 

This document is intended to simplify and supplement, not replace Beyond 20/20’s official 
documentation.  In case of any discrepancies or if you seek more information about the 
IVT browser, refer to Beyond 20/20’s documentation. 

This guide was originally created by the Alberta Office of Statistics and Information (OSI), 
and later updated by the Alberta Open Government Program.  The guide is intended to 
provide basic procedural information about viewing and using Ivation tables (IVTs), which 
is a proprietary data file format from the company Beyond 20/20. 

Information, steps, and screenshots in this guide may not exactly match your user 
experience with the actual Beyond 20/20 Professional Browser (IVT browser).  For 
example, you are now required to run the IVT browser as a standalone program, whereas 
this guide was originally created when the IVT browser was previously embedded in the 
webpages of the former datalink website (internal government site). 

To open IVT files, users must have Beyond 20/20 Professional Browser ("IVT browser") 
installed on their computer.  For Government of Alberta (GOA) staff, workstation security 
restrictions may prevent you from installing the IVT browser on your own. If this is the 
case, contact your Ministry's Service Resource Coordinator (SRC) to assist with the 
installation. (If your ministry does not have an SRC, then contact the GOA Service Desk.) 

Due to a licensing agreement between the GOA Open Government Program and Beyond 
20/20, the IVT browser downloaded from a GOA website must only be used with IVTs 
found on GOA sites. 

This guide assumes you have the IVT browser already installed on your computer, and 
you have opened an IVT file from a Government of Alberta website. 

Introduction 

IVT data files enable users to view multidimensional data and microdata.  IVTs can 
display aggregated statistics, time-series trends in a multi-dimensional format that can be 
modified and exported quickly and easily.  

With the IVT table action features, you select items to view, set dimension orders, and 
present reports containing the most relevant information for you. Tables can be 
downloaded to export data in a variety of formats such as .csv, .xls, or .IVT, for use with 
specialized analysis tools such as SPSS and SAS. With the chart action features, you 
can select chart types such as line, bar, column, pie, etc. IVT tables are supported with 
descriptive metadata to clarify the context of the information for better understanding and 
statistical interpretation. 

Pivoting and nesting capabilities make it easy to switch data dimensions and display 
more than one dimension along rows and columns. Additionally, with the dynamic data 
format, you can integrate and manipulate information, such as totals and percentages 
from available data sources. 
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Concepts 

A table is an integrated presentation of multi-dimensional data and descriptive text. 
Tables are composed of descriptive components, dimension field information and data 
values. When an IVT table is opened, datalink presents the data in a table view. 

A dimension describes an attribute of the table data, such as sex, geography, or time. 
Tables can have up to ten dimensions. 

An item is an element of a dimension; for example, June might be an item of the Month 
dimension, and Male an item of the Sex dimension. 

Viewing and Using IVTs 

Tabs  

The IVT opens the table view displayed with Table and Chart tabs available for selecting 
different presentations of the data.  

You can use the tabs to view the data in a number of different ways. 

Table tab  Displays the current report as a table.  

Chart tab  Displays the current report as a chart.  

 

 

Working with Tables 

Selecting the Table tab or selecting an information product displays the data associated 
with the selected information product in a table. The data in the table is organized into 
columns and rows.  The following image shows the different areas for the presenting the 
data contained in an IVT file displayed in table view.  

Table Action 
Buttons 

https://serva.beyond2020.com/osi/Common/Help/en/wdshelp.htm
https://serva.beyond2020.com/osi/Common/Help/en/wdshelpcharts.htm


  IVT User Guide 

Unrestricted Draft Version 1.2 August 2015  

 

 

A dimension describes an attribute of the data table. It is a category of data, such as 
Geography, Regions, Fields of Study, Indian Status, Gender, Age or Education Type (as 
seen in the table above).  

Tables have three dimension positions: Column, Row, and Other. The orientation of the 
dimensions changes the view of the data displayed in the data table. The view can be 
changed by using the table action buttons or by dragging and dropping the dimensions 
to different positions.  

Table Action Buttons                  

    

The table action buttons are present on Table pages and are described below: 

  
Select items to view You can use the Item selection page to choose the items for each 

dimension in your report. 

 
Download  Click to download a report in .xls, .IVT, or .csv format. 

  
Totals and 
percentages 

Click to display your data as row and column totals or percentages. 

  
Set dimension order Click to open the Set dimension order page to reorder dimensions 

without dragging and dropping. 

  
Reset default view Click to undo any changes you have made to a table view. 

  
View printable version This button prepares your report for printing using the settings in 

configured through the Print setup feature described below. Once 
your report is formatted, you can print using your browser's Page 
Setup, Print Preview and Print commands. 

 
Print setup Click to open the Print Setup and set printing references. To preview 

the results of this configuration, click the View printable version button 
described above.  

Dimensions 

Data Table 

https://serva.beyond2020.com/osi/Common/Help/en/tableactionprint.htm
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Table Actions 

Select items to view 

  
To open a dimension on the Item selection page, use the "Select items to view" 
button. 

The Item selection page enables you to choose the items that will make up a dimension.  

To select dimension items  

1. Click the Select items to view button.  

2. From the list, select the name of the dimension whose elements you want to view in 
the table. 

 

The Item selection view of the dimensions is displayed.  

3. Select the dimension from the list of dimensions. The list of items associated with the 
dimension is displayed in the panel on the right-hand side of the display.  

 

List of dimension 
items associated with 
the selected 
dimension 
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Select the items for the dimension.  

4. After you select the items to display, click: Show selected  

 

 

The display refreshes to show only the selected dimension items. 

5. Click Show table to return to the table view with the new dimension item setting.  

 

 

Download  

   
To download the current table view to your computer, click the "Download” 
button on the toolbar.  

Click on a format for the download. The following formats are available: 

 Beyond 20/20 table format (*.IVT)  

 Microsoft Excel format (*.xls)  

 Comma-delimited ASCII format (*.csv)  

 Semicolon-delimited ASCII format (*.csv)  

Items 
selected 
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Note: In some cases when opening a downloaded CSV file in MS Excel, all the data 
appears in a single row instead of being properly distributed across the spreadsheet.  

The following workaround will enable you to view the data correctly: 

 In MS Excel, select:  
Data menu > Text to columns > Delimited > Next > Comma/Semicolon > Finish  

Notes on downloading report data 

 All data for IVTs is downloaded; only data in the current table view is downloaded for 
the other formats.  

 All selected items will be downloaded, including inactive “Other” dimension items. 
(IVT only.)  

 Downloaded IVTs are automatically saved in the latest Beyond 20/20 file format, 
currently version 6.2.  

 Footnotes are retained when saving a report in IVT or XLS format, but not when 
saving as a CSV file.  

 The limit for downloading a report to Microsoft Excel 2007 format (XLS) is 16,384 
rows by 256 columns. Exceeding either limit will cause the download to fail with an 
error message explaining which limit has been exceeded. (Note that in this case rows 
and columns are not the same as rows and columns of data cells. For example, titles, 
subtitles, and the empty spaces between them also count as rows.) 

Totals and percentages 

   
To display your data as row and column totals or percentages, use the "Totals 
and percentages" button on the toolbar. 

To apply totals or percentages to the current report, select one of the options:  

 Row total (The total of all the values in a row)  

 Column total (The total of all the values in a column)  

 Percentage of row total  

 Percentage of column total 

Once you have chosen an option, a checkmark appears beside it. Click on a selected 
option to deselect it. 

 Totals appear as the first item in the innermost row or column dimension. Total cells 
are a different color than regular data cells.  

 Percentages replace all the data values in the current report. They are displayed with 
a percentage sign (%). 

Note: The Display totals/percentages button is only active if totals, percentages, or 
both have been enabled by the Administrator. 

Notes on totals and percentages 

 Totals and percentages are calculated based on the current selections along the 
innermost row or column dimension. (Total and percentage calculations can apply to 
a maximum of 8,000 items.)  

 Percentage values are calculated by dividing each data value by the sum of the items 
in the innermost dimension. (Missing values are treated as zeroes in percentage 
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calculations.) (Note: Sort arrows do not appear if percentages have been applied to 
the data.)  

 You cannot download totals or percentages along with a report. The downloaded 
report will appear as if totals or percentages had not been applied.  

 Total and percentage options persist until you change them.  

Set dimension order 

 
To open the Set dimension order page for a table, click the "Set dimension order" 
button on the toolbar.  

 

 

You can use the Set dimension order page to reorder dimensions without dragging and 
dropping.  

1. Select the dimension you want to move.  

2. Use the left and right arrow buttons to place dimensions in the Columns, Rows, 
and Other dimension areas.  

Note: A table must have at least one row and one column dimension. 

Or  

Use the up and down arrow buttons to nest dimensions in the desired order. The 
first dimension listed will be in the outermost position. The remaining dimensions will 
nest inside the first one in the order they appear in the list.  

3. When you have finished, click Apply. 

Reset default view 

   
To undo any changes you have made to a table, click the "Reset default view" 
button on the toolbar to return to the original table view.  

 

Use the left and right arrow 
buttons to move the selected 
dimension between the 
Columns, Rows and Other lists.  

Use the up and down arrows to 
nest the selected dimension 
above or below other 
dimensions in the same list.  
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View printable version 

  
To view your table view in printable form, click the "View printable version" button 
on the toolbar. 

This button prepares the table view for printing using the settings in Print setup. Once 
your table is formatted, you can print it using your browser's Page Setup, Print Preview 
and Print commands.  

 The printed report for the table will be divided into pages. Each page will show the 
table's title and dimension names (including “Other” dimensions) and its source 
information.  

 The last page or pages will display all the footnotes and missing values. 

Print setup 

  
To open the Print setup page and set printing preferences, click the "Print 
setup" button on the toolbar.  

 On the Print setup page, make your choices and then click Apply.  

Note: Some of the choices here are the same as the choices in Page Setup in your web 
browser. Before you start printing, make sure that the settings are the same in both 
places.  

Note: If you choose the "Color" printing option, you must enable background color and 
image printing in your browser, as follows: 

Internet Explorer: Tools menu > Internet Options > Advanced > Printing > Print 
background colors and images 

Firefox: File menu > Page Setup > Options / Format & Options > Print Background (colors 
& images)  

Viewing the Table Data  

Scrolling Through the Table 

Scroll bars appear if your data does not all fit in the data table area. To scroll to any part 
of your data, do any of the following: 

 Drag the scroll bars.  

 Click beside the scroll bars.  

 Click the scroll bar arrows. (One click on a scroll bar arrow scrolls by one row or 
column.)  

 Use a mouse with a scroll wheel to scroll three rows or columns at a time.  

 Use the arrow keys on your keyboard:  

 Pressing an arrow key scrolls in the selected direction by one row or column.  

 SHIFT + Arrow scrolls by one page of rows or columns.  

 CTRL + Arrow scrolls to the extreme edge in the indicated direction. 

 Use the PAGE UP/PAGE DOWN keys on your keyboard to scroll by one page of rows or 
columns. (This is the same as SHIFT + Arrow key.)  

 Use the HOME/END keys on your keyboard to scroll to the extreme top or extreme 
bottom. (This is the same as CTRL + Up Arrow/CTRL + Down Arrow.) 

https://serva.beyond2020.com/osi/Common/Help/en/tableactionprint.htm
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Sorting 

You can sort by the data in any column.  

  Click on the Sort ascending and Sort descending arrows in the column heading 
row to sort the table by the column. The arrows change color when they are clicked.  

 Click again to unsort. Unsorting reverts to the default sort order.  

Note: Sort arrows do not appear if Totals or Percentages have been applied to the data. 

Viewing Footnotes and Missing Values 

Footnotes and missing values provide more information about a cell's data. 

Note: Data is defined as "missing" if it is absent for some defined reason, such as being 
unavailable or confidential. (A missing value is not the same as a zero or a null value.) 
The text of a missing value usually explains why the data is missing. 

 To display the text of footnotes and missing values, hover over a cell that contains a 
footnote or missing value indicator. The footnote or missing value appears in a 
popup. 

 Footnote indicators appear inside brackets. For example: "(2,§)"  

 Missing value indicators can appear alone in a cell or in combination with footnote 
indicators. They do not appear inside brackets. For example: "- - -"  

Using Dimensions  

The names of column items appear along the top of a table’s data area while the names 
of row items appear down the side of a table’s data area. Other dimensions that can be 
placed in the table are listed at the top of the data area.  

 

 

                                

                      

 The dimension name that appears for the Column, Row or Other dimension is always 
underlined. Clicking a dimension name opens the Item selection page for that 
dimension.  

Other Dimensions 

Row Dimension 

Column Dimension 

https://serva.beyond2020.com/osi/Common/Help/en/selectitems.htm
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For example, if you click the “Education” dimension for the table, the Item selection 
page for the education appears (as shown below).  

 

 If the IVT file is supported by summary information, an icon ( ) appears next to it. 
Click the icon to view the summary and any notes for the dimension, items, type and 
description.  

 

For example, if you click the icon beside the file name, you will see the summary information 
shown below.  

 

 

Other Dimensions  

"Other" dimensions appear above the table area. They are not on the rows or the 
columns, although their values can affect the view of the data displayed in the table.  
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 The name of an “Other” dimension appears first in its dimension tile. The name is 
always underlined. Clicking a dimension name opens the Item selection page for that 
dimension.  

Dimension Items 

Dimensions are made up of items which are sometimes referred to as "dimension 
members".  

For example, the “Sex” dimension includes the items “Male” and “Female” it might also 
include an item called “Total” or  “All”, whose value would be calculated by totaling the 
values of the other items. 

 

 

Similarly, a “Age’ dimension could include the items  

 

      

 The name of the currently active item appears on the right-hand side of an “Other” 
dimension tile.  

 

 

Clicking on the Next item and Previous item arrows (  ) for the active item allows 
you to cycle through all the items in the dimension. (The data values in the table 
change to reflect which item that is currently active.) For example, to view the other 
items under the Sex dimension tile, click the Next | Previous item arrows.  

https://serva.beyond2020.com/osi/Common/Help/en/selectitems.htm
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Orienting Dimensions  

There are two main methods for setting the dimensions used for the data displayed in 
tables.  

 Use the Set dimension order page. To open the Set dimension order page, click the 

“Set dimension order” button on the toolbar ( ). For information on this feature, 
see the description of the “Set dimension order” button (Set dimension order).  

 Drag and drop the dimension into the desired orientation. With this method, you can 
switch dimension locations, you can add dimensions to be displayed in additional 
columns, or nest dimensions in an existing row.  

Switching Dimensions 

When you switch dimensions, the dimensions exchange positions. You can switch any 
dimension with any other. 

 To switch dimensions, click on the textured area of the dimension tile. The cursor 
changes to a four-headed arrow and the dimension tile changes color and size. 
Drag and drop the dimension onto the dimension you want to switch. The underlying 
dimension changes color to show when the dragged dimension can be dropped. 

  

In the following example, the Sex “Other” dimension is dragged to the row dimension 
area.  

 

 

The entire row dimension tile changes color to show that you can drop the dragged 
dimension onto it, switching their places.  
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When the dimensions are switched, the “Geography” dimension moves to the “Other” 
dimensions area, while the “Sex” dimension is now the row dimension as shown below.  

 

Moving Dimensions 

You can move the row, column and other dimensions by dragging and dropping them. 
Both the rows and the columns must always contain at least one dimension.  

Adding a New Column  

1. Drag the dimension below the column dimension until a yellow line appears below 
the dimension name.  

 

 

 

2. Drop it.  

The table display changes to show the additional data in a new column.  

 

Note: Do not drop the dimension on top of another dimension or the dimensions will 
switch places.  

Nesting Row Dimensions 

Nesting row dimensions places one dimension inside another. It allows a report to display 
more than one row dimension at a time. 

 You can nest dimensions by dragging and dropping them. The underlying dimension 
changes color on one edge only, to indicate where the nested dimension will appear.  
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In the screenshot below, the Indian Status “Other” dimension has been dragged to the 
edge of the row dimension. The edge of the row dimension has changed color to show 
that the dragged dimension can be dropped and nested into it. 

 

 

After dropping the dimension, the table display changes to show additional data in a new 
row for each item.  

 

 

.  
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Filtering the Data Displayed  

You can limit the data displayed in the table by narrowing the criteria for the data 
displayed. One way to do this is by limiting the number of dimensions. A second way is to 
use the Item selection option.  

1. To open the Item selection page, click the “Select items to view” action button ( ).  

2. From the drop-down menu, select the dimension of interest.  

 

3.  
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The Item selection page for the selected dimension is displayed.  

 

 Select and de-select the check boxes for the individual data items.  

Tip: When a large number of data sets are available, it can be easier to unselect all items 
at a given level in a column or row and then select only the items to include in the table.  

Levels  

  
Levels on the Item selection page represent the way data is nested under 
other data. For example, in this example the Total residential and non-
residential data is comprised of the totals for the Residential and Non-
residential buildings.  

Note: You may not see different levels for dimension items.  

 To unselect all the items at a given level in the tree view, click the Clear level button 
(x) for the level.  

 To select all the items at a given level in the tree view, click the Select level button 

() for the level.  
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Selecting Ranges  

When you want to select a range such as a date range, use the Select range option.  

1. Clear all of the items in the list by clicking the (x) above the list.  

2. Select the Select range check box.  

 

3. Select the first item in the range.  

 

4. Select the last item in the range. 
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The page refreshes. All the items within the range as well as the first and last items 
are now selected.  

 

5. After all the items and dimensions are selected, click Show Table to view the data.  
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Working with Charts 

 

The Chart tab displays your data in the form of a chart or graph.  

 

 First a preview chart appears where you can adjust the dimension selections. Once 
you are satisfied, click the preview chart to enlarge it.  

 The number of rows in a chart is limited to the number of available colours (64 by 
default). If a chart has too many rows to display in one chart it will be split into 
multiple preview charts.  

 There is no limit to the number of columns a chart can have. Therefore a large data 
series of more than 64 items should be placed on the columns.  

 A pie chart can only represent one data series. If a table has more than one data 
series, multiple preview charts will be created.  

 To view your data in the form of a table, click the Table tab. 
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Chart Action Buttons 

 

The Chart action buttons are present on Chart pages and are described below: 

  
Select items to view You can use the Item selection page to choose the 

items for each dimension in your chart. 

 
Select chart type Click to change the chart type (column, bar, pie, etc.). 

 
Set dimension order Click to open the Set dimension order page to reorder 

dimensions without dragging and dropping.  

 
View printable 
version 

This button prepares your chart for printing using the 
settings in Print setup. Once your chart has finished 
formatting, you can print using your browser's Page 
Setup, Print Preview and Print commands. 

Chart Actions 

Select items to view 

 
To open a dimension on the Item selection page, use the "Select items to view" 
button. 

The Item selection page enables you to choose the items that will make up a dimension. 
Click the name of the dimension whose items you want to view. 

Chart types 

  
To change the chart type, click the "Chart types" button on the toolbar. 

The following chart types are provided: 

  Pie   3D pie 

  Doughnut  3D doughnut 

  Bar  3D bar 

 Stacked bar   Column (Default) 

  3D column   Stacked column 

 Line   Spline (Note: A spline chart is a line 
chart with smoothing applied.) 

  Pyramid (Note: A pyramid chart consists of two similar bar charts 
presented back-to-back for easy comparison.) 

 

https://serva.beyond2020.com/osi/Common/Help/en/tableactionprint.htm
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Set dimension order 

 
To open the Set dimension order page, click the "Set dimension order" button 
on the toolbar. 

 

You can use the Set dimension order page to reorder dimensions without dragging and 
dropping.  

1. Select the dimension you want to move.  

2. Use the left and right arrow buttons to place dimensions in the Columns, Rows, 
and Other dimension areas.  

Note: A table must have at least one row and one column dimension. 

Or  

Use the up and down arrow buttons to nest dimensions in the desired order. The 
first dimension listed will be in the outermost position. The remaining dimensions will 
nest inside the first one in the order they appear in the list.  

3. When you have finished, click Apply. 



  IVT User Guide 

Unrestricted Draft Version 1.2 August 2015  

 

View printable version  

  
To view your report in printable form, click the "View printable version" button on 
the toolbar. 

When you click his button, it prepares your report for printing using the settings in Print 
setup. Once your report has finished formatting, you can print it using your browser's 
Page Setup, Print Preview and Print commands.  

 The printed report will be divided into pages. Each page will show the report's title 
and dimension names (including “Other” dimensions) and its source information.  

 The last page or pages will display all the footnotes and missing values. 

https://serva.beyond2020.com/osi/Common/Help/en/tableactionprint.htm
https://serva.beyond2020.com/osi/Common/Help/en/tableactionprint.htm
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Glossary 

Active 

Currently selected option. Any window and/or object currently selected is “active”. 

Aggregate 

To calculate a single data value which summarizes the data associated with more than one 
consecutive period of time. 

ANSI Character Set 

The American National Standards Institute 8-bit character set. 

Application window 

The window that contains your workspace, the menu bar, and (if available) a toolbar. 

Document windows are displayed in the workspace. 

Cell 

The smallest unit of data in a table view. The number that is displayed in a cell is common to 
all of the items on display, including the items in the Dimension bar and the intersecting items 
in the column and row dimensions. 

Check Box 

A small square box that is displayed beside an option in a dialog box. It can either be selected 
or cleared. When an option is selected, a check mark appears in the check box. 

Code 

A symbolic value that uniquely identifies an item. A code can be an abbreviation or a 
combination of numbers and letters. 

Column 

A sequence of numeric values related to the column dimension of a table view. A column 
contains one value for each row in the view. 

Column Dimension 

The dimension whose items are currently on display in the columns of a table view. 

Cursor 

The border that highlights the active cell in a table view. You can move the cursor from one 
cell or item to the next using the Previous Item and Next Item buttons. 

Dimension 

An aspect of the data (such as sex or region), which is broken down into one or more items 
(such as male and female, or Canada and U.S.A.). A dimension can be displayed in a 
dimension tile or along the columns or rows of a table view. 

Dimension View 

A window which shows all codes and labels that are associated with a dimension of a table or 
with a source field of an extract. 

Display Frequency 

The selected interval of time between consecutive items on display in a time series 
dimension. 
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Document Window 

A window inside the application window. A document window can contain a table view, a 
dimension view, or a chart view.  

Drag 

To move an object on the screen from one area to another, or to select multiple choices or 
objects from a dialog box option or a view. To drag, position your cursor over the object you 
want to relocate or select. Click on and hold the left mouse button, then move the mouse. As 
the mouse is moved, either the object is repositioned on the screen, or multiple choices/items 
are selected. 

Drop 

To release the left mouse button after an object has been repositioned on the screen. When 
the button is released, the object is displayed wherever the mouse pointer is currently 
pointing. 

Export 

To extract data from an existing file format and translate it into a different format. 

Field 

A set of codes or a set of labels for all of the items in a dimension. 

Footnote 

A textual description that provides information about the data in a cell. To view a footnote as a 
popup, place your mouse cursor over a cell that contains a footnote indicator. (In some cases, 
display of footnote indicators and popups may be suppressed. Footnotes can also be 
indicated by cell coloring.) 

Footnote Indicator 

The visible marker in a table cell that indicates a footnote is present. Footnote indicators are 
gray in color and they appear in brackets on the left-hand side of a table cell. (In some cases, 
display of footnote indicators and/or footnote descriptions may be suppressed. Cell coloring 
may also be used to indicate that a footnote is present.) 

Highlight 

To make an object on the screen stand out by displaying it in reverse video or in color. 
Highlighting indicates that an object is selected, and that it will be affected by the next 
command. 

Index Numbers 

The sequential numbers in the column on the left side of the dimension view window. There is 
one index number for each item in the dimension. 

Item 

An element of a dimension. An item can be identified by its unique code. It may have one or 
more labels assigned to it. 

Keyword 

A word that you can search for (using the Search Components dialog box) to locate relevant 
tables quickly. 
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Label 

A word or series of words that name a person, object, or place. A label could also be a time 
value (such as day, month, quarter, or year), a symbolic value (such as a combination of 
letters and numbers, or an abbreviation), or a unit of measurement. 

Maximize 

To enlarge a window to its maximum size, or to turn the selected icon into the active window 
by choosing the Maximize command from the icon's Control menu. 

Minimize 

To collapse a window or a document into an icon by choosing the Minimize button, or by 
choosing the Minimize command from the window's Control menu. 

Missing Value 

A textual description that provides information about a cell value that is defined as "missing." 
Values might be defined as missing because they are unavailable or confidential. To view a 
missing value as a popup, place your mouse cursor over a cell that contains a missing value 
indicator. 

Missing Value Indicator 

A marker placed in a table cell to indicate that the cell’s value is defined as missing. Missing 
value indicators are gray in color and they appear on the right-hand side of a table cell. 

Nest 

To display more than one dimension along the columns or rows in a table view. 

Object 

A general term that refers to any graphic on the screen you can drag. 

Path 

The route the operating system follows through the directory structure to locate a directory or 
a file. 

Record 

The basic logical unit of a database containing all source fields. 

Report 

A printed IVT table document. 

Row 

A sequence of numeric values related to the row dimension of a table view. A row contains 
one value for each column in the view. 

Row Dimension 

The dimension whose items are currently on display in the rows of a table view. More than 
one dimension can be nested in the row dimension area. 

Shortcut Key 

A key combination that can be used as an alternative to the mouse for choosing a command 
from a menu. 

Shortcut Menu 

Any menu that is displayed in a document window when the right mouse button is pressed. 
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Source Field 

A subset of a record describing one complete variable comprised in the record. For example, 
Sex and Salary could be source fields of a human resources data base record. 

Switch 

To exchange the position of one dimension with another. 

Table 

An integrated presentation of multidimensional data and descriptive text. 

Table File 

A file that contains descriptive components, dimension field information, and data values.  

Table View 

The main display of a table. It is a window which shows the dimensions of a table, along with 
the cells and corresponding data from the source file. 

Worksheet 

A working copy of a table. Data in a worksheet may be manipulated without affecting the 
original table. Any table operations may be made on the worksheet even if the original table is 
read-only. 

Workspace 

The area of the application window where you work with documents. You can move document 
windows anywhere within the workspace. 


